Quick start |[nspectionWare

G U |d e Version: QSG-BC-rev1.5

Quick Start Guide introduces the basic components of the
InspectionWare NDE Development Platform and helps you to
get started using a C-Scan example.
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Learning to use InspectionWare

Run through tutorials that can
be found under the Help menu.
There are 'InspectionWare
Basics' tutorials that will show
you how to perform simple
tasks.

You can use the 'Quick Start'
guide to get a scan up and
running for you.
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INTRODUCTION
To InspectionWare components

There are only three types of components used when developing an InspectionWare system.

Manager Windows, a Toolbox and Custom User Interfaces replace the rigid structure of dialog
boxes and menus commonly found in other NDT systems. Managers are where the action
happens. Tools are the building blocks. User Interfaces are custom panels, which you create,
to make systems simpler and more productive.

This, in our view, is the best way of building both custom and simplified NDE systems.

Manager Windows U- Managers (@] |
rA (Y
- - v Hes
Tools dragged into a Manager Window are called nodes - . u IE,
that connect with each other forming useful hierarchical ifj Acquisition
trees or sequences to automate signal processing and -
inspections. :'j Background Tasks
The nodes used in Managers have properties (settings) _gly' Data
and tasks (actions). Properties are set by double clicking -
. C . Events
nodes and tasks are selected by right clicking. _,JL.’H
a7 | Global Varables
Toolbox * ]
) ) ) :?J Inspection
All tools reside in the toolbox and are organized by '
functionality based on how they are used in the .é!j Mation
Manager Windows such as acquisition, inspection and
motion.
i :) Toolbox - Acquisition e X
User Interfaces ' He Vew Wndow Utits
. g P
User Interfaces start as blank panels and contain only _LJT: [D g
the controls you place on them to do a particular job. + () Acquisition e
() Annotations @ MAplexers
. I Background Tasks () Pulsers
InspectionWare Desktop £ Data 8 Aam
Q Everts {3 Aam Combination I
. . ) Images
When a node is dragged from a Manager into the % = Inspection % Ampitude g
InspectionWare Desktop (Blue Space), an appropriate g~ o (& Data Logger
window is automatically created for displaying A-Scans, H @ Processors bl
i . # () User Interfaces i UT Gate
B-Scans, C-Scans, Strip Charts or Motion Control. & Variables e
i) Workspace
X | = Group Digitize
These are default windows for advanced users or they S
are used by developers when first configuring systems. 3 Phesed Aray Sweep
« (1 » | € 2. Oua Mﬁr | » !




GET STARTED

Using a C-scan example showing the use of InspectionWare Toolbox and Managers

This example demonstrates how InspectionWare components are used to build a simple C-scan
application.

L | Page 3
1. Add Devices to InspectionWare using the Device Manager
—3
Used for adding new devices to InspectionWare Functionality is distributed and appears in
or troubleshoot connectivity issues. relevant sections of the Toolbox
~~— Aecquisition 7| Mation
‘-Jf-j | Page 4 '—ﬁj | Page 5
2. Configure Acquisition by adding 3. Configure Motion by adding motors,
instruments, setting properties and selecting encoders, motion axes and setting their
the data outputs properties
—

—a, | Inspection
‘-EJ | Page 6

4. Configure and Run Inspections to acquire data and save scans

—a | Data
]E.j | Page 7

5. Review and Process Saved Data for offline analysis and generating reports

| Page 8

6. Build Custom User Interface displaying only the controls you need
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ADD DEVICES TO INSPECTIONWARE

Using the Device Manager

InspectionWare can only use devices which have been defined in the Device Manager. The
device’s functionality is distributed in appropriate toolbox folders leading to a de-cluttered
toolbox that contains only the devices that are used in your system.

Add New Device
1. Open Device Manager:
Menubar > Managers—> Device Manager

2. Click [*]to open Add Device Window.
3. Select device from drop down list in Add Device Window.

4. Configure device properties. Click OK.

Connect and Test Device Communication
5. Rightclick on the device name to connect.

6. In case of connectivity issues the following icons may appear:

? InspectionWare is not connected to the device or is not
communicating with the device.

H Error- Device cannot be connected or the device driver is
not installed.

Once Added
7. Close the Device Manager. From now on, it will only be needed
to troubleshoot connectivity issues or add new hardware.

8. Access device functions from the toolbox.

| Add Device [
Device: ITEX UT 340} -
i NDTS RapiDAQ-PRX A

Name  |NDTS RapidScan2
Version Panametrics 5300PR
=) Systen|Parker ACR
= o A Pl Semulton
1 Pickering Test

Baudratd QM| SONDA 007CX Airscan

Test Coq Quantum Composers

Model N RD Tech MCDU
REI Mation Controller
Connect RIP Device
Ritec RT_4000 P/R N
Simulated Digitizer
Simulated DIO
Simulated Motion Controller
SOCOMATE USPC-3100
Sonix St8100
Sonix StB1G
Timer
TomaScan Digitizer Device
Uniwest ECT
US-Ultratek PCI-PR/UT

UWASI Controller M
W8 Devices (]
) p—
#)(x] [¢][8]
.
h-% Waveform Digtizer
o= Point Digitizer
N Mux

< Simulated Motion Controller @

£} Motor
™ Encoder

C-Scan Example:
1. Add a Simulated Digitizer and Simulated motion Controller
2. Exit Device Manager
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CONFIGURE ACQUISITION

By adding instruments, setting properties and selecting the data outputs

Instruments to be used in your system must be first dragged into the Acquisition Manager.

Drag tools onto the instrument in the Manager to specify data outputs such as Gated signals,
Amplitude, Time of Flight.

Set properties by double clicking nodes, execute tasks by right clicking and view related data by
dragging nodes to the desktop blue space. A connected node only operates on the data output
of its parent node viz. the node on which it was dropped. The hierarchy is shown by dashed
connection lines. View or hide child nodes in a tree by clicking on the [ or & symbols on the
left of each parent node.

Setup Instruments
1. Drag required instruments from the Acquisition
Toolbox to the Acquisition Manager. Managers\Acquisition @ x|

2. Drag required data output tools such as Gate, -

Amplitude, and Time of Flight onto the instrument = hap Simulated A Scan 27 4 %
or its child nodes. '

= Gate 1

3. Double click on each node to open and set EH-}- Time Cf Flight 5010 =%

roperties. i
prop & Amplitude 0.896

Click on any component to see its help. Hover on
any component to see tooltip.

H Pin/unpin window contents

B oo L

e Vew Processng X-Axs Took Layout \Wndow

\ -) o . @ ¢ o §
(HRAQ S (¢z

Simulated A Scan

Launch Data Viewer
4. Draginstrument nodes from the Manager to the
desktop blue space.

00 05 L

5. Selected instrument properties can also be
adjusted from its data viewer such as its Gain,
Gate.

0 us 10 15 20 25 30 35 40 45 50100

(36750 us) =-0005V

6. Right-Click in the Data Viewer to display associated
tasks.

C-Scan Example:

3. Drag a Simulated A-Scan

4. Drag a Gate on Simulated A-Scan. Drag a Time of Flight and Amplitude on the Gate
5. Set Ch1 Gain in Simulated A-Scan to 1.0

6. Inthe Data Viewer, drag and resize the Gate to cover the first two peaks
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CONFIGURE MOTION

By adding motion axes components and setting their properties

Motors and encoders for each motion axis present in your system must be first dragged into
the Motion Manager. A motor is not required if the axis is externally controlled and an encoder

is not required if no position readouts are needed.

Set properties by double clicking nodes, execute tasks by right clicking and launch motion
control panel by dragging a motion axis node to the desktop.

Setup Motion Devices
1. Drag required motion components from the Motion
Toolbox.

2. Double-Click on each motion device node to set
properties.

Split Manager Window

&) Refresh Manager Window

Launch Motion Control Panel
3. Draga motion device node to the InspectionWare
desktop.

4. This panel provides a full set of manual controls for
a motion axis.

Managers\Acquisition @&

=
= hap Simulsted A Scan 27 4 ¥
hr—
EH.}. Time Of Flight [ 3070 =
i—.}. Ampltude [ D.836

Managers\Motion @ |
[ 'S
o

& X [zimulated)

1 Position 0.500

£} Speed 0.000

o

i Y [simulated)

™ Position 7000

Lk Speed 0.000

&l Motion Controller El&u

X ¥
| 0.000 in | 0.000 in
| 0.000 infs | 0.000 infs
l Forward ” Stop l [ Forward ” Stop l
l Backward ” Goto l [Backward ” Goto l

C-Scan Example:

7. Add two Simulated Motion Axis for Scanning and Indexing
8. Setencoder calibration units to “mm” from the motion axis properties box
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CONFIGURE AND RUN INSPECTIONS
To acquire data and save scans

Scans to be performed by your system such as 1D-Scans, 2D-Scans, Timed-Scans must be first
dragged to the Inspection Manager and connected with its instruments from the Acquisition
Manager and motion axes from the Motion Manager. Scanning is controlled by the scans,
moves, sequences and other tools placed in the Inspection Manager.

Set scan properties by double clicking nodes, execute tasks by right clicking and view scans by
dragging the scan node to the desktop blue space.

Setup Scan Managers\Inspection @ X
1. Dragrequired scan types (Inspection F A _ .
toolbox=>Scanning folder). | - rt— l-ﬁ |-/T]| |E—j | B

s 7 0 | & o5 @ o
E Time Of Right Y

2. Connect with motion axis nodes to enable "

motion control.

3. Connect with data output nodes to enable

data acquisition. [ 20 Scan - Tome Of Fight 1 of 1) I

He Vew 3SGonng Toos Laout  Window

bEHFAQASCEE (@

Set “Save Data Prompt When Scan Completed” in
the Options tab of 2D Scan properties box to True

L o) et

& Indicates node connection is being made I )~cn
= | 2
.|
% . .. [a o
Indicates scan is in progress 1= g
@ -
&

Start Scanning
4. Dragthe 2D Scan node into the
InspectionWare Desktop to launch Data

Viewer. (60.750men, 49 750mm) kv
bl O

5. You can now Run @, Pause @ and Stop @
Scans using the Data Viewer.

0 Y (mm)

0 X(mm) 20 30 40 50 660 N0 &0 %0

C-Scan Example:

9. Dragin a 2D Scan tool to setup a C-Scan.

10. Drag Time of Flight from Acquisition Manager to the 2D Scan node.

11. Drag X and Y Axis from the Motion Manager to the 2D Scan node.

12. Set X as Scan Axis with 100mm length and Y as Index Axis with 50mm length. Set start from current
position to False.

** SEE FOOTNOTE ON PAGE 7 ON HOW TO SET UP TEST BLOCK SIMULATION FOR THE ABOVE C-SCAN EXAMPLE**
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REVIEW AND PROCESS SAVED DATA
For off-line analysis and generating reports

Saved data files must be first opened in the Data Manager for viewing, post processing and
generating reports. Perform data analysis by dragging data processing tools from the
Processors Toolbox.

Set properties by double clicking nodes, execute tasks by right clicking and view related data by
dragging nodes to the desktop blue space.

Open Saved Data File Open ...
1. Drag Data Set tool from the LEEn T TR
Data Toolbox to Data Save
Manager. File ’ Save As...
E Datg Set Execute Processors Clear Flename
Copy .
Show Acquisition Info
2. nght click on the Data Set Properties (C-5can-5im.Test Block.sdt) Show Meticn Info
node and select File>Open to Help (C-Scan-Sim Test Block.sdt) Show Scan Info
select a saved data file.
@13 Replaces existing node with
selected tool/node
Managers\Data (@] |

Is|=|=]

= -Scan-Sim.Test Block =ct [l -

® Cannot drop/connect selected m r‘tﬂ | | l.@

tool/node here

View and Process Saved Data e Statistics 2D
3. Drag Data Set onto the M 5530
L ]
Desktop to view saved Scans. = :
& Minimum 7950 2
4. Drag processing tools such as » Average 8.307
Cluster Analysis, Statistics 2D * Hangs 1.350
from the Processors Toolbox = RMS 8.325
to analyze and process the ® Std Dev. 0.562 W

1

1 | 1] | ¥

data.

C-Scan Example:
13. Drag Statistics 2D tool (Plane Processors Folder) onto the Data Set node.

**SETUP SIMULATED TEST BLOCK TO ACQUIRE MEANINGFUL C-SCAN DATA FOR THE EXAMPLE IN THIS GUIDE:

1. Right-click on the Simulated A-Scan node in the Acquisition Manager and select Test Block as the
Simulation Type.

|
2. Double-click on the test block icon —— to open its properties. From the drop down menu set Axis 1
and Axis 2 fields to X and Y. Ensure that the Region type is Step Block with dimensions of 100mmx50mm.
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BUILD CUSTOM USER INTERFACES

Displaying only the controls you need

Build custom user interfaces by dragging only the required controls from Manager Windows

onto your user interface. Exit design mode to activate your custom interface.

Set properties by double clicking interface objects and execute tasks by right clicking when in

design mode.

Open New Interface Window
1. Open anew user interface window in design mode.

Opens new user interface (Blank) in design mode

E_ﬁi Enter or exit user interface design mode

Add Controls and Start Using your Custom Interface
2. Drag Simulated A-Scan and 2D Scan from the Managers
Window to the user interface.

3. Drag Tasks for e.g. Execute, Save As and properties
such as Gain.

4. Right click on each object to display its Title, Label etc.
5. Select multiple objects and right click to group them.

6. Draga Tab Page Tool from the User Interfaces toolbox.
Double click the default Tab title (e.g. Page 1) to
rename.

7. Exit design mode.

In design Mode: Highlight source of a
user interface control by selecting
“Flash Source” from the right click

menu.
Live Data E
B Page Properties -
[EEEN Lve Data
B Background
Background Mode Caolar
Bachkground Color FOFOFOFD
Background Gradient Flat
Border Maone
B Controls |
Control Amangement Floating
Synchronize Display Zooms False
User Level All Users
Enable True
2 Publish to PDF |
Auto Name PDF False LI

C-Scan Example:
14. Create your custom C-Scan User Interface.

0 Y{(mm) 20

..............




FREQUENTLY USED
InspectionWare Icons

Manager Window Icons Toolbar Icons

B y

&) Refresh contents of Manager Open an existing workspace
Organize tree E Save current workspace

[

Add a new folder W Archive current workspace

@ Move to parent of current subfolder ‘ﬂ% Write workspace description
@ Opens search box for the Manager [ Show or hide Managers window
% Show or hide Managers tree ‘ Show or hide Toolbox

Split Manager window ‘ Show or hide My Toolbox

Help Window Icons

Previous help topic / Next help topic

Open new data viewer (Blank)

E—
Open new user interface)in design mode

g Pin/unpin window contents

Help home

i nl
% Open motion control panel

5_% Enter or exit user interface design mode
4 Search help

0 Show or hide help window

c

Cursors

) o Enable or disable automatic refreshing
& Indicates node connection is being made

% * Refresh once (Single Step)
Indicates scan is in progress

Ky

1 Can drop selected tool here

t=¥ Can add selected tool to modify node output

® Cannot drop/connect selected tool/node here

({? Replaces existing node with selected tool/node
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